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Privire de ansamblu

Stilurile  sunt una dintre cele mai  performante facilităţi ale Writer-ului  (n.t.:  componenta a 
OpenOffice.org, Writer s-ar putea traduce prin  Scriitorul, pronunţându-se [raităr]; am păstrat 
denumirea originală neschimbată deoarece este de fapt un nume propriu). Pe de altă parte, ele 
sunt necesare pentru a folosi Writer-ul la potenţialul maxim. Acest capitol face o introducere a 
stilurilor pornind de la zero, fiind potrivit pentru cei care înca nu ştiu nimic despre ele. Iar la 
sfârşitul lecturii, sper că veţi folosi stilurile de pagină, paragraf  şi caracter fără probleme.

Copyright şi m rci înregistrateă
Conţinutul acestui document este protejat de Licenţa de Documentaţie Publică, versiunea 1.0 
(numită în continuare Licenţa); aveţi permisiunea de a folosi această documentaţie numai dacă 
sunteţi  de  acord  cu  prevederile  licenţei.  O  copie  a  licenţei  este  disponibilă  la  :
http://www.openoffice.org/licenses/PDL.rtf.

Documentaţia originală a fost scrisă în limba engleză şi este intitulată  Introducere în stiluri: 
Stiluri  pentru paragraf,  pagină şi  caractere. Autorul  primei  versiuni  este Daniel  Carrera  © 
2004. Toate drepturile rezervate. (îl  puteţi contacta la  dcarrera@openoffice.org). Contactaţi 
autorul numai pentru a semnala erori în documentaţie. Pentru întrebări despre cum să folosiţi 
programul, înscrieţi-vă pe lista de mail pentru utilizator şi scrieţi întrebările dumneavoastră 
acolo. Lista de mail o găsiţi la adresa http://support.openoffice.org/index.html.)

Traducerea în limba română a documentaţiei a fost realizată de Amăriuţei Gheorghe aka ghrt. 
Toate  drepturile  cuvenite  traducătorului  rezervate.  Pentru  eventualele  inadverdenţe  cu 
originalul în limba engleză sau cu programul îmi puteti trimite mail la ghrt@k.ro, sau pe lista 
de discuţii dev@ro.openoffice.org. Vă rog să specificaţi în subiectul mesajului "Introducere în 
stiluri" sau "open office", deoarece primesc foarte mult spam.

Toate mărcile înregistrate aparţin utilizatorilor legitimi.

P rerea dumneavoastră ă
Dacă  doriţi  să  faceţi  comentarii  sau  sugestii  despre  acest  document  vă  rog  să  scrieţi  la 
authors@user-faq.openoffice.org. Pentru  versiunea  în  limba  română,  adresa  este 
dev@ro.openoffice.org.

Mul umiriţ
Le mulţumesc celor care au revizuit acest capitol.

Introducere în stiluri iii
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Modific ri şi actualiz riă ă
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1.1 29 Jan 2005 Revised for OOo 2.0

1 27.02.2005 Tradus în limba română
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Introducere

Ce sunt stilurile?
Cei mai mulţi oameni sunt obişnuiţi să scrie un document specificând direct ce vor să vadă. 
De exemplu, puteţi specifica fontul, mărimea acestuia şi grosimea (să zicem, Helvetica 12pt, 
aldin - bold ).

Stilurile sunt, prin contrast, atribute indirecte. Le folosim zilnic. De exemplu, când împărţim 
calculatoarele în două categorii: desktop, pentru birou,  şi laptop, cele mobile. De fapt este 
vorba de caracteristicile fiecărei categorii, deoarece calculatoare foarte diferite sunt denumite 
desktopuri  şi la fel este şi cu laptopurile. Aceste două cuvinte, desktop şi laptop,  ajung să 
desemneze fiecare câte o  categorie de calculatoare, aşa că atunci când zicem desktop nu ne 
referim în mod direct la un anumit calculator. În mintea noastră vor fi prezente caracteristicile 
generale ale categoriei respective, adică stilul acesteia.

Stilurile în OpenOffice.org (o să îl numim de aici încolo OOo) reprezintă o modalitate de a 
face acelaşi lucru într-un document. Să folosiţi stiluri înseamnă să încetaţi a spune “mărimea 
fontului 14pt, Times New Roman, aldin,  centrat”, şi să vă obişnuiţi a spune “titlu”. Cu alte 
cuvinte, stilurile înseamnă o deplasare a accentului de la cum arată la ce reprezintă cuvintele şi 
textul.

De ce s  folosim stiluri?ă
OOo vă oferă o noţiune foarte puternică şi cuprinzătoare a stilurilor. Stilurile vă ajută să daţi 
un aspect uniform documentelor dumneavoastră. De asemenea, este uşor să faceţi schimbări 
majore de formatare. De exemplu, vă puteţi decide să schimbaţi alineatele la toate paragrafele, 
sau să schimbaţi fonturile la toate titlurile. Dacă documentul este mare şi nu aţi folosit stiluri, 
acest lucru poate deveni foarte dificil. Stilurile vă ajută să faceţi aceste lucruri cu uşurinţă.

Ora este 9:50 A.M. şi Ioana tocmai  termină compunerea de 30 de pagini 
pentru  astăzi  la  şcoală.  Când  parcurge  documentul,  observă  câteva 
probleme:

• Textul trebuie scris cu Arial în loc de Times New Roman.

• Titlurile trebuie să fie albastru-închis şi cu spaţiu la început.

• Titlurile trebuie să apară în partea de dreapta-sus a fiecărei pagini în 
afară de prima.

• Paginile pare trebuie să aibă marginea mai mare în dreapta, iar cele 
impare în stânga.

Din fericire, Ioana a folosit OOo şi a lucrat cu stiluri. Poate face schimbările 
în 2 minute, astfel încât nu va întârzia la şcoală.

Introducere în stiluri 1
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Feluri de stiluri
Writer-ul OOo cunoaşte 5 tipuri de stiluri:

• Stilurile de paragraf afectează un întreg paragraf.

• Stilurile de caractere afectează o porţiune de text în cadrul unui paragraf.

• Stilurile de pagină afectează formatarea paginii (mărimea, marginile, etc).

• Stilurile de cadru ("frame styles") afectează cadrele şi imaginile.

• Stilurile de listă afectează listele numerotate şi cele cu semne grafice (ca aceasta).

Primele trei stiluri sunt cele mai folosite. Acestea sunt explicate în acest capitol. Stilurile de 
cadru şi  cele de listă sunt discutate în capitolul  intitulat "Lucrul  cu stiluri" (Working with 
Styles).

Aceste stiluri  sunt disponibile în cadrul unei ferestre separate de bara cu «unelte» (butoane 
grafice  -  iconiţe,  câmpuri  sau  liste  de  selecţie),  numită  Stiluri  şi  formatare  (Styles  and 
Formatting), arătată în  Imaginea 1. (Dacă sunteţi în OOo, apăsaţi tasta  F11 ca să o vedeţi.) 
Această fereastră este discutată în secţiunea următoare.

Notă Stiluri şi formatare este o fereastră separată. Puteţi să o (re)poziţionaţi pe ecran cu 
mausul.

Introducere în stiluri 2

Imaginea 1. Fereastra Stiluri şi formatare; sunt arătate iconiţele pentru cele 5 tipuri de stiluri

Stiluri de listă

Stiluri de pagină

Stiluri de paragraf

Stiluri de caracter

Stiluri de cadru
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Folosirea stilurilor de paragraf

Primii paşi
OpenOffice.org  foloseşte  unealta  numită  Stiluri  şi  formatare  pentru  a  administra  stilurile. 
Conceptul de stiluri şi fereastra Stiluri şi formatare sunt cel mai bine explicate folosind un 
exemplu.

1) Creaţi  un  document  nou  (alegeţi  File  >  New  >  Text  Document sau  apăsaţi 
Control+N).

2) Tastaţi “Heading 1” în el. Atenţie! Cursorul trebuie ca să rămână pe aceeaşi linie.

3) Apăsaţi iconiţa Stiluri şi formatare   situată pe bara de formatare (Formatting Bar) 
sau apăsaţi tasta  F11. Aceasta face să apară o fereastră intitulată Stiluri  şi formatare 
(Styles and Formatting) (vedeţi  Imaginea  2).

4) Aveţi grijă ca fereastra să arate secţiunea cu stilurile de paragraf (apăsaţi iconiţa din 
stânga-sus din fereastra Stiluri şi formatare, şi anume  ).

Daţi dublu-clic în fereastra Stiluri şi formatare, elementul numit  Heading 1 (la fel ca textul 
dumneavoastră). Aceasta va face două lucruri:

• Textului introdus (şi toată linia aferentă) i se va aplica stilul Heading 1.

• Heading 1 va fi adăugat în meniul Aplică stil (Apply Style).

Introducere în stiluri 3

Imaginea  2. Apăsaţi pe iconiţa Stiluri şi formatare  ca să apară fereastra.

Stiluri şi formatare

Stiluri de paragraf

Cursor

Stiluri şi formatare

Stilul curent



CIORN  - bazat  pe software nefinalizatĂ ă  Folosirea stilurilor de paragraf

Meniul Aplică stilul (Apply Style) este ilustrat în Imaginea 3. Vă ofera acces direct la stilurile 
care sunt folosite deja în documentul curent.

Folosind meniul Aplic  stilul (Apply Style)ă
Meniul  Aplică stilul  (Apply Style) enumeră  stilurile  de paragraf  care  sunt folosite deja în 
documentul  curent.  Puteţi  să selectaţi  stiluri  din  acest  meniu,  ca  şi  din fereastra  Stiluri  şi 
formatare. Ca un exerciţiu, apăsaţi  Enter, tastaţi nişte text şi selectaţi  Heading 1  în meniul 
Aplică stilul. Textul dobândeşte proprietăţile stilului Heading 1.

Imaginea 3. Aplicarea stilurilor de paragraf

Modificarea stilului de paragraf
Puterea  stilurilor  rezidă  în  abilitatea  de  a  le  modifica  în  funcţie  de  nevoi.  În  următorul 
exemplu, vom avea nevoie de trei linii de text cu stilurile Heading 1, Heading 2 şi Heading 3. 
Documentul dumneavoastră ar trebuie să semene cu cel din Imaginea 4. Stilul Heading 1 va 
trebui aplicat cuvântului “Title”, Heading 2 la “Subtitle 1” şi aşa mai departe.

Introducere în stiluri 4
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Imaginea 4. Textului i s-au aplicat stilurile Headings 1–3.

Să presupunem că doriţi să modificaţi stilurile:

• Heading 1 va fi centrat.

• Heading 3 va fi cu spaţiu la început de rând.

Centrare pentru Heading 1

În fereastra Stiluri  şi formatare,  apăsaţi  clic  - dreapta pe "Heading 1" şi  alegeţi  Modifică 
(Modify) (ca în Imaginea 5).

Imaginea 5. Modificarea unui stil.

Când se deschide fereastra Stilul paragrafului (Paragraph Style), alegeti categoria Aliniament 
(Alignment tab), selectaţi Center (ca în Imaginea 6) şi apăsaţi OK.

Introducere în stiluri 5
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Imaginea 6. Centrare Heading 1

Acum tot ce i s-a aplicat stilul Heading 1 va fi centrat (ca în Imaginea 7). Dacă mai aplicaţi 
stilul Heading 1 şi la alt text, şi acesta va fi centrat, de asemenea.

Imaginea 7. Textul cu stilul  Heading 1 este centrat.

Spa iere la început de rând pentru Heading 3ţ
În fereastra Stiluri şi formatare, daţi clic - dreapta pe Heading 3 şi alegeţi Modifică (Modify) 
(ca şi înainte). Când apare fereastra Stilul paragrafului (Paragraph Style), executaţi următorii 
paşi:

1) Alegeţi categoria Spaţiere (Indents & Spacing).

2) În cadrul secţiunii Indent, introduceţi spaţiere înaintea textului de 1.5cm (0.6 inch), ca 
în Imaginea 8.

Rezultatul ar trebui să fie cel din Imaginea 9.

Introducere în stiluri 6

Centrat

Categ. Aliniere

Centered

Imaginea 8. Introducerea spaţierii

Categoria Spaţiere Spaţiere
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Imaginea 9. Textul cu stilul Heading 3 este spaţiat.

Stiluri legate (Linked styles)
Unele dintre stilurile OpenOffice.org sunt legate împreună. Aceasta înseamnă că schimbările 
într-un  stil  afectează  toate  stilurile  legate  la  acesta.  De  exemplu,  toate  stilurile  numite 
"Heading" (cum sunt Heading 1, Heading 2) sunt legate cu un stil numit  Heading. Această 
dependenţă este ilustrată în Imaginea 10.

Imaginea 10. Stiluri legate.

Cu titlu de exemplu, să presupunem că doriţi să schimbaţi fontul nu numai la Heading 1 sau la 
Heading 2, ci la toate stilurile legate cu Heading. Cea mai uşoară cale de a face aceasta este să 
folosiţi legăturile existente între stiluri. Deschideţi fereastra Stiluri şi formatare (apăsaţi F11) 
şi selectaţi Heading (Imaginea 11).

Imaginea 11. Selectaţi stilul Heading.

Introducere în stiluri 7
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Deschideţi fereastra Stiluri de paragraf (Paragraph styles) corespunzătoare stilului  Heading 
(clic - dreapta > Modify) şi selectaţi categoria Font. Selectaţi un font şi apăsaţi OK (priviţi 
Imaginea 12).

Acum  fonturile  pentru  toate  stilurile  "Heading"  au  fost  modificate  dintr-un  foc.  Acum 
documentul dumneavoastră ar trebui să arate ca în  Imaginea 13.

Imaginea 13. Toate stilurile Heading au acum noul font.

Crearea stilurilor proprii (custom styles)

Aţi observat ca fereastra Stiluri  şi formatare (Styles and Formatting) vă oferă câteva stiluri 
predefinite, cum sunt Heading 1 şi Text body. Dar dacă aveti nevoie de un stil special, pentru 
scrierea  unei  poezii,  deoarece  nici  unul  dintre  cele  predefinite  nu  se  potriveşte?  Cu 
OpenOffice.org vă puteţi crea stiluri după preferinţă.

Introducere în stiluri 8

Imaginea 12. Selectaţi fontul pentru stilul Heading.

Selectaţi fontul Cat. Font 
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În această secţiune, vom crea un stil numit  Poem, şi unul numit  TitluPoem, cu următoarele 
caracteristici:

• Poem: Centrat, mărimea fontului 10.

• TitluPoem: Centrat, aldin, mărimea fontului 12.

În plus,  după  textul  cu  stilul  TitluPoem va urma  obligatoriu  text  cu  stilul  Poem.  Cu  alte 
cuvinte, când veţi apăsa Enter, stilul textului se va schimba în Poem.

Notă Cititorul atent va fi observat desigur acest comportament până acum. După ce tastaţi 
un titlu cu stilul aferent şi apăsaţi Enter, stilul se schimbă înapoi la "Text body".

Crearea stilului Poem
Primul nostru exemplu este stilul Poem. Vom folosi stilul Default ca punct de pornire.

1) Apăsaţi iconiţa  sau tasta F11.

2) Daţi clic - dreapta pe Default şi alegeţi Nou (New) (ca în Imaginea 14).

Imaginea 14. Creaţi un nou stil.

Aceasta  deschide  fereastra  Stilul  paragrafului,  la  categoria  Organizator (Organizer tab). 
Pentru a crea un stil propriu, trebuie să înţelegeţi şi să configuraţi primele trei elemente.

Nume (Name) Acesta este numele stilului, cum sunt şi Heading 1 sau Text body.

Numiţi-l Poem.
Următorul 
stil (Next 
Style)

Acesta este stilul ce va urma în mod obişnuit stilului  Poem. După ce 
apăsaţi  Enter în timp ce tastaţi text cu stilul  Poem,  acest stil  va fi 
utilizat.

Scrieţi  tot  Poem.  Când  veţi  apăsa  Enter pentru  strofa  următoare, 
textului i se va aplica tot stilul Poem.

Legat la 
(Linked With)

Dacă stilul  Poem este legat cu altul,  de exemplu cu  Default, atunci 
orice  schimbare  a stilului  Default va afecta şi  Poem,  după  cum aţi 
văzut cu Heading în secţiunea precedentă.

În exemplul nostru nu vrem aceasta. Setaţi această opţiune ca Nimic (– 
None –) . Aceasta înseamnă că Poem nu este legat cu nici un alt stil.

Introducere în stiluri 9
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styles)

După ce faceţi aceste modificări, ecranul dumneavoastră ar trebui să arate ca în Imaginea 15.

Imaginea 15. Configuraţia iniţială a stilului Poem. Setaţi primele trei câmpuri editabile după cum 
vedeţi.

Următorul pas este să configuraţi alinierea şi caracteristicile fontului pentru acest stil.

• În categoria Aliniere (Alignment tab), selectaţi Centrat (Center).

• În categoria Font, selectaţi mărimea fontului de 12pt (puncte tipografice).

Apăsaţi OK pentru a salva stilul Poem.

Felicitări! Tocmai v-aţi creat propriul stil.

Crearea stilului TitluPoem (PoemHeading)
Vom crea un nou titlu, numit TitluPoem. (Din anumite considerente, nu am editat / tradus şi 
imaginile,  astfel  încât  în  acestea  denumirea  stilului  este  PoemHeading).  Urmaţi  aceeaşi 
procedură ca mai înainte, cu aceste diferenţe:

• Următorul stil (Next style): Selectaţi Poem, nu TitluPoem.

• Legat cu (Linked with): Heading.

Fereastra ar trebui să arate ca în Imaginea 16.

Introducere în stiluri 10
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Imaginea 16. Configurarea pentru stilul TitluPoem (în imagine, PoemHeading).

Acum stabiliţi caracteristicile noului stil:

1) În categoria Aliniere (Alignment tab), selectaţi Centrat (Center).

2) În categoria Font, alegeţi îngroşare (bold) şi mărimea 14pt.

Apăsaţi OK pentru a salva noul stil TitluPoem.

Introducere în stiluri 11

Cat. Organizator Câmpuri editate
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Poezia...
Şi acum să testăm stilurile proaspăt create pentru a vedea cum arată şi dacă sunt bune de 
folosit. Dacă scrieţi o poezie, aceasta ar trebui să arate similar cu cea din Imaginea 17.

Imaginea 17. Poezie de Robert Frost (1874-1963).

Introducere în stiluri 12
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Modificarea stilurilor
Unul dintre cele mai importante avantaje ale utilizării stilurilor este că ele permit formatarea 
documentului  să  fie  schimbată  fără  a-l  modifica  special  pentru  aceasta.  De  exemplu,  să 
presupunem că aţi scris o carte destul de lungă (să zicem 100 de pagini). Şi să presupunem şi 
că a doua zi nu vă place cum arată, sau aceluia căruia îi trimiteţi documentul nu îi place cum 
arată (ce aţi scris nu este treaba noastră).

Pentru a învăţa despre modificarea stilurilor, vom face următoarele schimbări:

• Stilul Poem va fi spaţiat în loc să fie centrat.

• Vom adăuga un stil PoemAuthor legat la Poem, cu diferenţa că este aldin (bold) şi are 
mai multe spaţii în faţa sa.

Spa ierea stilurilor ţ Poem şi TitluPoem

În primul rând, setaţi stilul Poem cu aliniere la stânga:

1) În fereastra Stiluri şi formatare (Styles and Formatting), selectaţi Poem, clic - dreapta şi 
selectaţi Modifică (Modify).

2) În categoria Aliniere (Alignment tab), selectaţi Stânga (Left).

Precizaţi spaţierea:

1) Apăsaţi categoria Spaţiere (Indents & Spacing tab).

2) Sub Indent, introduceţi spaţierea înaintea textului ("before text") de 5cm (aproximativ 
2 inch).

Gata! Apăsaţi OK, şi ar trebui să vedeti modificarea formatării textului. Faceţi acest lucru şi 
pentru stilul TitluPoem.

Crearea stilului PoemAuthor

Scopul acestui stil este să separe numele autorului de restul poeziei. Deja ştiţi cum să creaţi un 
stil nou. Executaţi aceeaşi  procedură ca şi mai înainte, când am creat stilul  Poem. Stabiliti 
următoarele caracteristici:

• Nume (Name): PoemAuthor.

• Următorul stil (Next style): Default.

• Legat la (Linked with): Poem.

Acum,  configuraţi  PoemAuthor aşa  cum  aţi  configurat  stilul  Poem,  dar  cu  următoarele 
diferenţe:

• Font: aldin (bold).

• Spaţierea (Indentation): 8cm (3.2 inch).

• În  categoria  Spaţiere (Indents  &  Spacing tab),  sub  Spacing,  stabiliţi  spaţiul  de 
deasupra paragrafului (spacing above the paragraph) la 0.5cm (0.2 inch). Aceasta va 
mări spaţiul dintre textul poeziei şi numele autorului.

Introducere în stiluri 13
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Imaginea 18 arată cum ar trebui să arate categoria Spaţiere (Indents & Spacing tab) în acest 
moment. Apăsaţi OK pentru a salva stilul. Acum scrieţi numele autorului poeziei (în exemplu, 
“Robert Frost”) folosind noul stil PoemAuthor, după cum am descris în “Primii paşi” la pagina 
3.

Rezultatul final 

După toate modificările, poezia ar trebui să arate ca în Imaginea 19.

Imaginea 19. Rezultatul final, folosind trei stiluri proprii.

Trucuri (Tips and tricks)
Puteţi configura fereastra Stiluri  şi formatare astfel  încât să afişeze numai stilurile  proprii. 
Pentru aceasta, daţi clic în partea de jos a ferestrei şi selectaţi Stiluri proprii (Custom Styles). 
După cum se vede în Imaginea 20, fereastra afişează acum numai stilurile Poem, PoemAuthor 
şi TitluPoem.
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Imaginea 20. Afişarea numai a stilurilor proprii.

Utilizarea  stilului  de  pagin  şi  numerotareaă  
paginilor

Stilurile de pagină sunt pentru pagini ce stilurile de paragraf sunt pentru paragrafe. Aşa cum 
acestea  din  urmă  definesc  proprietăţi  ale  paragrafului  (mărimea  fontului,  culoarea,  etc.), 
stilurile de pagină pot defini caracteristicile paginii (margini, mărimea acesteia etc.).

O situa ie realţ ă
Christian este avocat în California, SUA. Pentru actele sale, 
prima  pagină  poartă  antetul  său,  iar  pe  paginile  ulterioare 
este menţionat numai  destinatarul,  data şi numărul  paginii. 
Aceasta  se  poate  realiza  folosind  stilurile  de  pagină.  De 
asemenea, acestea sunt folosite şi pentru a stabili marginile 
paginilor conform cu cerinţele instanţelor californiene.

Stilul de pagină pentru pagina curentă este afişat pe bara de statut ("status bar") (Imaginea 21).

Imaginea 21. Stilul pentru pagina curentă este afişat pe bara de statut.

Deschideţi fereastra Stiluri şi formatare şi apăsaţi iconiţa Stiluri de pagină (Page Styles) .
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Imaginea 22. Selectarea stilului de pagină.

Daţi clic - dreapta pe stilul de pagină activ la acest moment (Imaginea 22)  şi alegeţi Modifică 
(Modify). Fereastra afişată este prezentată în Imaginea 23.

Numerotarea paginilor
Mulţi oameni află de stilurile de pagină când doresc să numeroteze paginile. OpenOffice.org 
oferă un sistem foarte performant de numerotare  pentru pagini,  dar pentru a-i putea folosi 
toate facilităţile va trebui să învăţaţi stilurile de pagină.

Preliminarii: câmpurile (fields)

OpenOffice.org foloseşte o facilitate numită  câmpuri (fields)  pentru a administra  numerele 
paginilor. Pentru a insera un câmp reprezentând numărul paginii, alegeţi Inserţie > Câmpuri 
> Numărul paginii (Insert > Fields > Page Number). Numărul paginii va apare scris pe un 
fond gri. Acel fond gri marchează un câmp.

Notă Fondul gri este acolo numai pentru a marca vizual, în timpul redactării, prezenţa unui 
câmp. Acest fond gri nu va fi tipărit şi la imprimantă.
Alegeţi  Vizualizare  >  Umbrire  câmpuri  (View  >  Field  Shadings)  pentru  a 
renunţa la această facilitate.
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Dacă aţi  văzut, în documente OOo,  liste, probabil  că aţi  observat fondul  gri.  Listele OOo 
folosesc  tot  câmpuri.  Câmpul  reprezentând  numărul  paginii  întotdeauna  afişează  numărul 
curent al paginii  în care este situat. Dacă însă este afişat textul "Numărul  paginii"  (“Page 
number”)  în  loc  de  un  număr,  apăsaţiCtrl+F9.  Această  combinaţie  de  taste  comută  între 
afişarea conţinutului unui câmp (adică ce reprezintă câmpul) şi rezultatul câmpului (adică ce 
rezultă în urma calculării conţinutului său).

Notă O explicare completă a câmpurilor excede acestui capitol.

Inserarea unui cap de pagin  (header)ă
În OOo, capetele de pagină sunt include în stilurile de pagină.

1) Deschideţi fereastra Stilul paginii (Page Style) (clic - dreapta > Modify).

2) Selectaţi categoria Cap de pagină (Header tab).

3) Selectaţi Cap de pagină vizibil (Header on) şi apăsaţi OK (ca în Imaginea 24).

Imaginea 24. Afişarea capului de pagină.

La acest punct ar trebui să vedeţi capul de pagină afişat pe pagina curentă, ca în Imaginea 25.

Imaginea 25. O pagină cu cap (de pagină).

Ce este atât de special cu aceste capete de pagină? Textul scris în ele apare pe toate paginile 
cărora li s-a asociat acest stil (puteţi încerca pentru a vă convinge!). Această caracteristică a 
capetelor, ca şi a finalurilor de pagină (footers), împreună cu facilitatea câmpurilor, reprezintă 
modalitatea de a obţine numerotarea paginilor în OOo.

PONT Puteţi de asemenea adăuga capete de pagină (headers)  şi prin intermediul meniului 
Inserare (Insert): Insert > Header > [page style alegeţi stilul de pagină dintre cele 
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afişate]. În mod similar procedaţi pentru a aplica finaluri de pagină (footers): Insert 
> Footer > [page style].

Simpla numerotare a paginilor

Cea mai simpla situaţie este aceea în care numărul paginii este afişat în partea de sus a paginii, 
atât şi nimic mai mult. Pentru a face aceasta, mutaţi cursorul în interiorul capului de pagină şi 
apoi selectaţi Inserare > Câmpuri > Numărul paginii (Insert > Fields > Page Number) 
(Imaginea 26).

Imaginea 26. Inserarea numărului paginii în capul de pagină.

Perfect! Acum pe fiecare pagină veţi vedea că apare numărul paginii.

Situa ii mai complexeţ
Sunt o mulţime de combinaţii interesante pe care le puteţi face fără a şti nimic despre stilurile 
de pagină. Iată câteva sugestii:

• Aliniaţi la dreapta capul de pagină astfel încât numărul paginii să apară în dreapta-sus.

• Adăugaţi cuvântul "pagina", astfel încât capul de pagină să conţină în final “pagina 1”, 
“pagina 2”, şi aşa mai departe.

• Adăugaţi titlul documentului,  astfel încât capul  de pagină să rezulte “Cartea mea de 
poezii, pagina 12”. Gândiţi-vă să folosiţi (să tastaţi) un spaţiu multiplu ("tab")  pentru a 
delimita titlul de numărul paginii.

• OOo  are de asemenea şi câmpul Numărul de pagini (Page Count) (îl găsiţi la Insert > 
Fields > Page Count). Utilizându-l, aţi putea, de exemplu, să aveţi un cap de pagină de 
genul “pagina 2 din 12”.

Aceste posibilităţi sunt ilustrate în Imaginea 27.
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Imaginea 27. Diverse combinaţii pentru numerotarea paginilor.

Mult mai multe variaţii sunt posibile. De exemplu, aţi putea folosi finalul paginii în loc de 
capul paginii pentru afişarea numărului paginii.

Caracteristica Stilul urm tor (Next Style)ă
Aţi  observat  caracteristica  Stilul  următor  (Next  Style)  când  am vorbit  despre  stilurile  de 
paragraf. Aceasta caracteristică este în mod special performantă în stilurile de pagină.

Alternarea a dou  stiluri de pagină ă
Poate cea mai obişnuită utilizare a caracteristicii  Stilul următor este să alternaţi între două 
stiluri de pagină. De exemplu, dacă scrieţi o carte, aţi putea să procedaţi astfel:

Paginile 
impare

• Numărul paginii în colţul din dreapta - sus.

• Numele autorului în capul paginii.

• Marginea din stânga mai mare.

Paginile pare • Numărul paginii în colţul din stânga - sus.

• Titlul cărţii în capul paginii.

• Marginea din dreapta mai mare.

Notă Marginile  sunt  stabilite  astfel  pentru a  face  legarea  sau  perforarea  paginilor  mai 
uşoară, deoarece filele cărţilor se tipăresc pe ambele feţe.

Acestea pot fi realizate utilizând ceea ce deja aţi aflat despre stilurile de pagină, completat cu o 
manipulare inteligentă a caracteristicii Stilul următor (Next Style). OOo vă oferă două stiluri 
de pagină denumite Right Page (dreapta) şi Left Page (stânga). 

În primul rând, setaţi stilul paginii ca Right Page (paginile din dreapta) să fie urmat de stilul 
Left Page (stânga) şi reciproc.

1) Din fereastra Stiluri şi formatare, deschideţi fereastra pentru configurarea (mai bine zis, 
modificarea) stilului Right Page (Imaginea 28).
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Imaginea 28.  Clic - dreapta pe Right Page şi alegeţi Modifică (Modify).

2) Alegeţi categoria Organizator (Organizer tab), şi setaţi Stilul următor (Next Style) 
ca fiind  Left Page (Imaginea 29). Aceasta înseamnă că, după o pagină cu stilul  Right  
Page, următoarei i se va aplica stilul Left Page.

3) Apăsaţi OK.

Imaginea 29. Stabiliţi Următorul stil (Next Style) ca fiind "Left Page".

4) Într-un mod similar, setaţi Left Page să fie urmat de Right Page.

Setati prima pagină a documentului ca "Right Page". Veţi observa alternanţa între cele două 
stiluri,  Right  Page şi  Left  Page.  Puteţi  de asemenea  observa în bara  de statut  schimbarea 
stilurilor(Imaginea 21) când treceţi la pagina următoare. Imaginea 30 ilustrează tranziţia dintre 
Right Page şi Left Page.

Imaginea 30. Stilurile "Right Page" şi "Left Page" alternează.

Acum vom putea stabili caracteristicile celor două stiluri, Right Page şi Left Page.

Stabiliţi caracteristicile paginii pentru stilul Right Page - folosit pentru paginile din dreapta.
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• Puneţi numarul paginii în colţul din dreapta - sus, şi numele dumneavoastră în capul de 
pagină.

• Dimensiunea  marginii  paginii  este  situată  la  categoria  Pagină (Page tab).  Stabiliţi 
marginea din stânga (left) la 4cm şi lăsaţi restul neschimbat. Vedeţi Imaginea 31.

Imaginea 31. Stabiliţi dimensiunea marginilor paginii în categoria Pagină.

Într-un mod similar, stabiliţi caracteristicile paginii pentru paginile din stânga (Left Page).

• Puneţi numarul paginii în colţul din stânga - sus, şi tastaţi un titlu (la libera alegere) în 
capul de tabel.

• Stabiliţi marginea din dreapta (right) la 4cm şi lăsaţi restul neschimbat.

Titlul paginii

Haideţi să încercăm ceva puţin mai complicat. Doriţi ca documentul dumneavoastră să aibă o 
pagină de titlu. O astfel de pagină este diferită de restul documentului:

• Nu are cap sau număr de pagină.

• Marginile laterale sunt egale.

Pentru titlul paginii  vom folosi stilul  Front Page (prima  pagină), care este oferit de  OOo. 
Stabilirea capului de pagină şi marginile este lasată ca exerciţiu pentru dumneavoastră. Partea 
dificilă este cum să împăcăm această pagină cu restul paginilor, cărora li se aplică stilurile 
alternante,  Right  Page şi  Left  Page.  Şmecheria  este  să  stabilim  caracteristica  Pagina 
următoare (Next Page) ca fiind "Right Page". 

Cu alte cuvinte:

Prima 
pagină(Front)

Next Style: 
Right Page

Paginile din 
dreapta (Right)

Next Style: Left  
Page

Paginile din stânga 
(Left)

Next Style: 
Right Page
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Am ilustrat această situaţie mai jos (Imaginea 32).

Imaginea 32. Succesiunea stilurilor de pagină.

Întrerupere manual  a paginiiă
Secţiunea precedentă a tratat caracteristica Stilul următor (Next Style). Această facilitate este 
suficientă pentru proiecte cu cerinţe de paginare elementară (de exemplu, rapoarte, scrisori, 
mici cărţi). Dar proiecte mai complexe cer un mai mare control asupra stilurilor de pagină. 
Acest control este furnizat de întreruperea manuală a paginii.

Ideea este simplă: întrerupeţi o secvenţă de stiluri de pagină, şi începeţi o altă secvenţă. Pentru 
a insera o întrerupere de pagină, alegeţi Inserare > Întrerupere manuală (Insert > Manual 
Break) şi alegeţi întrerupere pagină (page break). Această secţiune exemplică prin trei situaţii 
în care întreruperile de pagină sunt folositoare.

Exemplu: Capitolele

Scrieţi o carte care este divizată în capitole. Fiecare capitol începe cu un stil de pagină numit 
New Chapter (Capitol nou). Următoarele pagini alternează stilurile  Right Page şi Left Page. 
La sfârşitul capitolului, folosim din nou stilul New Chapter, pentru următorul capitol.

OOo nu oferă stilul New Chapter, aşa că va trebui să creaţi un stil propriu (vă reamintiţi de la 
pagina 8). Să presupunem că aţi şi creat stilurile de pagină cu următoarele caracteristici:

New Chapter Next Style: Right Page
Right Page Next Style: Left Page
Left Page Next Style: Right Page

Am realizat o reprezentarea vizuală în Imaginea 33.
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Imaginea 33. Succesiunea stilurilor de pagină.

La un moment dat veţi dori să începeţi un nou capitol. Urmaţi aceşti paşi:

1) Deplasaţi cursorul la sfârşitul capitolul, pe o linie goală.

2) Alegeţi Insert > Manual Break.

3) Selectaţi Page break, şi sub "stil" (style), alegeţi New Chapter.

Imaginea 34. Alegeţi întreruperea paginii, şi selectaţi stilul de pagină New 
Chapter.

Imaginea 35 ilustrează succesiunea stilurilor de pagină când folosiţi întreruperi de pagină.

Imaginea 35. Succesiunea stilurilor de pagină când folosiţi întreruperi.
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Exemplu: Inserarea unei pagini cu formatare specială
Uneori s-ar putea să aveţi nevoie să inseraţi o pagină cu formatare specială. De exemplu, o 
vedere este în format "landscape" (latura de jos a imaginii o constituie latura lungă a hârtiei), 
sau o pagină care are mai multe coloane. Şi aceste lucruri  pot fi realizate cu întreruperi  de 
pagină. Să presupunem că paginii curente i s-a aplicat stilul Right Page (dreapta).

1) Alegeţi Inserare > Întrerupere pagină (Insert > Manual Break).

2) Selectaţi stilul paginii (să zicem,  Special Page). Această pagină va fi în mod normal 
poziţionată pe partea stângă, aşadar i s-ar fi aplicat stilul Left Page.

3) Scrieţi ceva pe această pagină. Apoi inseraţi o altă întrerupere de pagină.

4) Apoi selectaţi din nou Right Page. Paginarea continuă ca mai înainte, exceptând faptul 
că o pagină care avea stilul Left Page a fost înlocuită de o pagină având un alt stil.

Explicaţiile sunt ilustrate în imaginea 36.

Imaginea 36. Inserarea unei pagini cu formatere specială.

Exemplu: Reluarea numerot rii paginilor: cazul prefe eiă ţ
Uneori vreţi dori să reluaţi numerotarea paginilor de la 1. Un exemplu tipic este atunci când 
ati scris prefaţa unei cărţi. O prefaţă obişnuită are următoarele caracteristici:

• Numerele paginilor sunt afişate în numere romane (i, ii, iii, iv, …).

• După prefaţă, documentul începe cu pagina din dreapta.

• Numărul paginii este din nou 1, şi formatul foloseşte cifre arabe (1, 2, 3, 4, …).

Pentru resetarea numărului paginii este nevoie de întrerupere de pagină.

Să presupunem că prefaţa foloseşte stilul Preface (care nu există, aşa că va fi un stil propriu). 
După prefaţă  urmează  stilul  Right  Page,  apoi  cele  două  stiluri,  pentru  paginile  dreaptă  şi 
stângă - Right Page şi Left Page alternează.

În primul rând, să facem lucrurile preliminare pentru stilul Preface (prefaţă):

1) Creaţi un nou stil de pagină numit Preface.

2) Stabiliţi  Stilul  următor  (Next Style)  ca fiind  Preface, din moment ce o prefaţă se 
poate foarte bine desfăşura pe mai multe pagini.
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3) Adăugaţi un cap de pagină stilului Preface şi inseraţi numărul paginii.

După aceea, alegeţi ca numele de pagină să fie afişate ca numere romane (i, ii, iii, iv, …):

1) Deschideţi  fereastra  stilului  de  pagină  pentru  Preface şi  selectaţi  categoria  Pagină 
(Page tab).

2) Sub Setări privind dispunerea (Layout settings), stabiliţi formatul ca fiind “i, ii, iii 
…”. Vedeţi Imaginea 37.

Imaginea 37. Stabiliţi formatul numărului paginii în cifre romane.

După ce prefaţa este scrisă, suntem gata să reluăm numerotarea paginilor. Urmaţi aceşti paşi:

1) Deplasaţi cursorul chiar la sfârşitul prefaţei, pe o linie goală.

2) Alegeţi Inserare > Întrerupere manuală (Insert > Manual Break). 

3) Selectaţi  Întrerupere pagină (Page break) şi alegeţi stilul  Pagina din dreapta (Right  
Page).

4) Selectaţi  căsuţa  Schimbă numărul paginii (Change page number) şi introduceţi  noua 
valoare, 1.

Acestea sunt vizualizate în Imaginea 38.

Introducere în stiluri 25

Formatul numărului de pagină



CIORN  - bazat  pe software nefinalizatĂ ă  Utilizarea stilului de pagin  şiă
numerotarea paginilor

Imaginea 38. Stabiliţi noul număr al paginii ca fiind 1 şi stilul paginii ca fiind Right Page.

Notă Nu puteţi atribui un număr de pagină impar pentru o pagină din stânga sau invers, 
unul par pentru o pagină din dreapta. OOo aderă la convenţia că numerele impare de 
pagini sunt pe partea dreapta şi cele pare pe partea stângă.

Această schimbare este vizibilă şi pe bara de statut (status bar). Secţiunea  Pagina (Page) a 
barei  acum include trei  numere,  şi  anume valoarea câmpului  "număr de pagină", numărul 
paginii curente şi numărul total de pagini din document. (Imaginea 39).

Imaginea 39. Numărul paginii în bara de statut.

Utilizarea stilurilor de caracter

Stilurile de caracter sunt complementare stilurilor de paragraf. Ca şi stilurile de paragraf, ele 
definesc caracteristicile textului (fontul, mărimea, grosimea), dar ele sunt aplicate unor blocuri 
de  text  mai  mici  decât  un  paragraf.  De  exemplu,  atunci  când folosiţi  stilul  de  caracter  
Emphasis pentru a reliefa cuvintele. În acest document până acum am folosit:

• Apăsările  de  taste  au  fost  marcate  prin  stilul  KeyStroke ("apăsare  de  tastă").  De 
exemplu, “pentru a lucra OOo pe tot ecranul, apăsaţi Control+Shift+J”.

• Căile din meniuri folosesc stilul MenuPath. De exemplu, “pentru a comuta umbrirea 
câmpurilor între vizibil şi neafişabil, alegeţi View > Field Shadings”. (n.t. aici autorul 
traducerii  trebuie să recunoască faptul că a fost mai puţin riguros şi doar a scris cu 
aldine textul tradus în română, fără a-i mai aplica stilul).
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De ce s  utiliz m stiluri de caracter?ă ă
Utilizatorii începători se întreabă adeseori, “de ce să utilizăm stiluri de  caracter?”, “prin ce 
este aceasta diferit de a îngroşa direct textul?”. Următoarea situaţie (reală) este ilustrativă.

O situa ie concludentţ ă
Jean  este  un  autor  profesionist  din  Australia.  Ea a  acceptat  să 
folosească stiluri de caracter după ce editorul i-a cerut să nu mai 
scrie căile din meniuri cu aldine, în toată cartea de 200 de pagini. 
Cum Jean nu folosise stiluri de caracter, a trebuit să editeze cele 
200 de pagini manual, cu un mic ajutor din partea funcţiei Caută 
şi înlocuieşte (Find and Replace).

După aceea a folosit în mod consecvent stiluri de caracter.

Stilurile de caracter nu au aşa de multe opţiuni ca cele de paragraf ori de pagină. Beneficiile în 
cazul lor sunt de o natură diferită:

• Schimbarea  opţiunilor  de  formatare.
Aşa cum ce i  s-a întâmplat  Jeanei  o  arată,  posibilitatea de a efectura  schimbări  de 
formatare întregului document poate fi importantă. Stilurile de caracter asigură aceasta.

• Consistenţa.
Stilurile de caracter ajută la a vă asigura că folosiţi în tot document aceleaşi notaţii.

• Focalizare  pe  conţinut.
“Combinaţiile  de  taste  trebuiesc  scrise  cu  aldine? Dar  meniurile?”
Un scriitor nu trebuie să-şi piardă timpul cu acestea. Alegerea notaţiilor vă distrage de 
la ceea ce trebuie de fapt să faceţi. Un stil de caracter cu un nume sugestiv (cum sunt 
Apăsare de tastă - KeyStroke sau Cale de meniu - MenuPath) vă vor degreva de această 
sarcină.

Alte situaţii în care se impune a folosi stiluri de caracter sunt descrise şi în alte ghiduri pentru 
utilizator.  Acestea includ marcarea numerelor  de capitole, de pagină, listele numerotate cu 
numere mai mare decât textul şi formatarea hyperlinkurilor (adreselor din Internet).

Utilizarea stilurilor de caracter
Deschideţi  fereastra Stiluri  şi  formatare (apăsaţi  F11)  şi  apăsaţi  al  doilea buton grafic din 
rândul  de sus  . Acesta va lista stilurile de caracter disponibile. Pentru a aplica un stil de 
caracter, sunt necesari doi paşi.

1) Selectaţi întregul text căruia doriţi să îi aplicaţi stilul.

2) Daţi dublu-clic pe stilul corespunzător din fereastra Stiluri şi formatare.
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Câteva exemple:

Acest exemplu este pentru stilul de caracter Emphasis.

Definiţie: O afirmaţie decriind semnificaţia unui cuvânt sau sintagme.

Notă Una din diferenţele dintre stilurile de caracter şi  cele de paragraf este nevoie de a 
selecta textul (în engleză este denumit pe scurt highlighting). Aplicarea stilurilor de 
caracter  implică  selectarea  textului  căruia  asupra  doriţi  să  îl  aplicaţi;  stilurile  de 
paragraf nu necesită aşa ceva.

Aplicarea şi îndep rtarea stilurilor de caracteră
Uneori veţi dori să îndepărtaţi formatarea unui bloc de text. Trebuie să rezistaţi tentaţiei de a 
face aceasta manual. Veţi avea numai necazuri mai târziu. Sunt două metode facile pentru a 
face această schimbare:

• Selectaţi blocul de text, daţi clic - dreapta şi alegeti Obişnuit (Default).

• Dacă aveţi deschisă fereastra Stiluri şi formatare, alegeţi stilul de caracter Default.

Notă Prima metodă poate fi folosită şi pentru a îndepărta formatarea manuală, nu numai 
prin intermediul stilurilor.

Migrarea c tre stiluri de caracteră
Pentru oamenii obişnuiţi să formateze textul manual s-ar putea să dureze până se obişnuiesc 
cu stiluri de caracter. Noi va oferim câteva sugestii pentru a face această tranziţie mai uşoară:

• Niciodată nu  amestecaţi  stilurile  de  caracter  şi  formatarea  manuală.  Formatarea 
manuală are prioritate faţă de stilurile de caracter. Dacă le combinaţi, s-ar putea să vă 
pierdeti timpul, frustrat ca stilurile de caracter nu funcţionează cum ar trebui.

• Clic  -  dreapta  >  Obişnuit  (Right-click  >  Default) îndepărtează  toate  formatările 
textului (atât cele manuale cât şi stilurile de caracter aplicate).

• Înţelegeţi  că  a  apăsa  butonul  grafic  pentru  îngroşarea  caracterelor  este  presupune 
acelasi efort cu selectarea unui stil de caracter.

• Lasaţi pe ecran fereastra Stiluri şi formatare, ca să vă fie la îndemână.

Introducere în stiluri 28


	O situaţie reală
	O situaţie concludentă
	Cuprins
	Privire de ansamblu
	Copyright şi mărci înregistrate
	Părerea dumneavoastră
	Mulţumiri
	Modificări şi actualizări

	Introducere
	Ce sunt stilurile?
	De ce să folosim stiluri?
	Feluri de stiluri

	Folosirea stilurilor de paragraf
	Primii paşi
	Folosind meniul Aplică stilul (Apply Style)
	Modificarea stilului de paragraf
	Centrare pentru Heading 1
	Spaţiere la început de rând pentru Heading 3

	Stiluri legate (Linked styles)

	Crearea stilurilor proprii (custom styles)
	Crearea stilului Poem
	Crearea stilului TitluPoem (PoemHeading)
	Poezia...
	Modificarea stilurilor
	Spaţierea stilurilor Poem şi TitluPoem
	Crearea stilului PoemAuthor
	Rezultatul final 

	Trucuri (Tips and tricks)

	Utilizarea stilului de pagină şi numerotarea paginilor
	Numerotarea paginilor
	Preliminarii: câmpurile (fields)
	Inserarea unui cap de pagină (header)
	Simpla numerotare a paginilor
	Situaţii mai complexe

	Caracteristica Stilul următor (Next Style)
	Alternarea a două stiluri de pagină
	Titlul paginii

	Întrerupere manuală a paginii
	Exemplu: Capitolele
	Exemplu: Inserarea unei pagini cu formatare specială
	Exemplu: Reluarea numerotării paginilor: cazul prefeţei


	Utilizarea stilurilor de caracter
	De ce să utilizăm stiluri de caracter?
	Utilizarea stilurilor de caracter
	Aplicarea şi îndepărtarea stilurilor de caracter
	Migrarea către stiluri de caracter




